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The Mississippi University for Women Alumni Association (MUWAA) serves and supports the 
University by involving alumni and friends with each other and MUW. MUWAA Chapters & 
Constituency Groups have a longstanding history of linking the alumni, affectionately known as the 
Long Blue Line, and the University. Joining an Alumni Association chapter or constituency group is 
one of the best ways to connect alumni across the nation and around the world. Alumni chapter & 
constituency group members are able to participate in a variety of activities to promote and build 
support for our University. This includes hosting alumni meetings, increasing positive public 
awareness of MUW, raising money for scholarships and University support, and assisting in student 
recruitment. Since these groups are voluntary, minimal guidelines are suggested to encourage their 
formation and to be able to tailor each chapter or constituency group to their needs and style. 

 
From time to time, the MUWAA will update these Guidelines. The most recent version can always be 
found on the website, https://longblueline.muw.edu/alumni/alumni- association. The Office of 
Development and Alumni staff is available to help make MUWAA Chapters & Constituency Groups a 
successful partner of the MUWAA and the University. Contact information is: 

 
MUW Office of Development & Alumni 

1100 College Street, MUW-10 
Columbus, MS 39701-5800 
Telephone: (662) 329-7295 

Fax: (662) 329-7466 
E-mail: developmentandalumni@muw.edu 

 
 

I. CHAPTER & CONSTITUENCY GROUP ORGANIZATION 
 

A. Chapter & Constituency Group Types: When forming an alumni group, there are 
four options available based on the composition of the members and structure 
desired. 

 
1. Formal Chapters - Groups of alumni within a certain geographical area 

who choose to elect officers, collect dues, and offer several opportunities 
throughout the year for alumni in their area to gather and/or support the 
University. 

https://longblueline.muw.edu/alumni/alumni-association
https://longblueline.muw.edu/alumni/alumni-association
mailto:developmentandalumni@muw.edu


 

2. Informal Chapters - Groups of alumni within a certain geographical area 
who prefer to not have officers or collect dues but rather have designated 
leader(s) whose only role is to coordinate occasional gatherings in the area. 
These chapters may choose to have only one formal or informal gathering 
per year but can have more if their members desire. 

3. Formal Constituency Groups - Groups of alumni who may live all across 
the nation or even around the world but share a common bond from their 
time at MUW or beyond. This may be a group from a specific major, social 
organization, graduation year(s), sport, etc. These formal groups have 
officers, and may choose to collect dues, and plans events supporting their 
special interests at the University. These groups may also choose to have 
their own bylaws which govern their group, but these bylaws may not 
supersede or contradict the Affiliation Agreement, MUWAA Bylaws 
approved by the overall body of MUWAA members, MUWAA Policies and 
Procedures, and the University. 

4. Informal Constituency Groups - Groups of alumni who may live all across 
the nation or even around the world but share a common bond from their 
time at MUW or beyond. This may be a group from a specific major, social 
organization, graduation year(s), sport, etc. These informal groups do not 
elect officers or collect dues. They may only choose to gather informally at 
certain events or may even choose to be solely a virtual group who 
connects exclusively through a social media page set up specifically for 
their group. 

 
B. Chapter & Constituency Group Establishment: There are three steps to 

begin organizing a chapter or constituency group. 
 

1. Contact the Office of Development and Alumni with your request. 
2. For Chapters, submit to the Office of Development and Alumni a list of 

counties and major cities and towns within a 75-mile radius of your 
community for a survey of alumni within this radius. Results, which 
typically take four to six weeks, will identify people who may be interested in 
becoming involved. For Constituency Groups, submit to the Alumni Office 
the specific type of alumni you are targeting (i.e., graduated with a degree in 
a certain major, was a member of a specific organization, or graduated 
between these years) for a survey of the number of alumni the University 
has on file who may fit your criteria. 

3. Once the queries are completed, the Office of Development and Alumni 
will contact the requesting party to let them know the results. If enough 
potential alumni are identified, the requesting party will then draft a letter 
to be sent by the Office of Development and Alumni via email to all those 
found during the query. This letter should explain what type of group the 
requesting party is wanting to form and give the recipients details about 
how to get involved. 



 

 

While the above steps are available to aid in the formation of a new chapter or group, 
it is not mandatory these steps be followed. Groups may choose to begin more 
informally through word of mouth or some other means. 

 
C. Chapter & Constituency Group Maintenance: To be considered an official 

Chapter or Constituency Group with the University, the following criteria is 
suggested. 

 
1. An annual Chapter/Constituency Group Status Report should be submitted 

to the Office of Development and Alumni each fiscal year on or before July 
1. A template of this report can be found at Exhibit 1 at the end of these 
guidelines or ask for a digital one from the Office of Development and 
Alumni. This report is brief and should require no more than thirty minutes 
to complete. The report should include names, mailing addresses, phone 
numbers, email addresses, and terms of service for all officers and 
directors, if any. Submission of this report allows the Office of 
Development and Alumni to keep the Chapter & Constituency Group 
webpage up to date with current group contact information so alumni 
visiting the webpage can know what groups are available and who to 
contact to get involved. 

2. After each chapter/group event, the President or designated coordinator 
should prepare a brief summary of the event and send to the Office of 
Development and Alumni with the information contained in Exhibit 2. 

3. For Formal Chapters, the following is also suggested. 
 

a. Officer Structure: At a minimum, Chapters should consider 
electing a president, president-elect/vice-president, secretary, and 
treasurer. All officers should be active members of the MUW Alumni 
Association and should be elected by a majority vote of 
membership at an annual meeting. The following responsibilities 
are suggested but not limited to: 

 
President 

● Ensures the Chapter operates in partnership with the 
MUWAA, the University, and the MUW Foundation 

● Maintains communication with the Office of Development 
and Alumni in coordinating all activities and 
communications 

● Serves as Chair of the Chapter Board of Directors 
● Presides over all Chapter and Board meetings 
● Directs the planning of all Chapter activities 

 
President-Elect/Vice President 

● Assists President in all aspects of program planning 



 

● Chairs committees or oversees projects as assigned by the 
President 

● Performs duties of the President in his/her absence 
 

Secretary 
● Chairs the membership committee 
● Monitors alumni lists and notifies the Alumni Office of 

changes in addresses, phone numbers, email addresses, 
births, deaths, marriages, etc. 

● Other duties as assigned by the President 
● Maintains minutes of Board and Chapter meetings 

 
Treasurer 

● Keeps financial records 
● Serves on the Chapter fundraising committee and works 

with the Office of Development in all aspects of fundraising 
● Secures approval for expenditures from Chapter Board of 

Directors 
● Responsible for processing Chapter bills for payment 

 
b. Terms of Office: Excluding the office of treasurer, all officers 

should serve a term of no more than two years. 
c. Board of Directors: The Chapter President can appoint members 

to the Board of Directors. It is suggested that the Board consist of 
the elected officers, the immediate past president, and six (6) 
appointed members. All members should be active, voting 
members of the Chapter and a diverse representation of alumni in 
terms of age, race, and gender. The Board should ensure all 
business affairs are managed to support the MUW Alumni 
Association, the MUW Foundation, and the University. 

d. Chapter Committees: Chapters, depending on their size, may 
maintain committees such as Recruitment, MUWAA and Chapter 
Membership, Scholarship and Fundraising, and Community 
Service and Publicity. 

 
D. Chapter & Constituency Group Funds:  Each Chapter and Constituency Group 

which elects to collect dues or donations has the choice to maintain these funds in 
a designated fund within the MUW Foundation or a bank account with an outside 
institution. 

 
1. If the Chapter or Constituency Group chooses to maintain an outside 

bank account, it is preferred that they follow these guidelines which 
provide benefits for the Chapter/Constituency Group and the donor. 



 

● The bank account should be opened in the Chapter or 
Constituency Group name with the MUW Foundation’s federal 
identification number. The Foundation will be the “owner” of the 
account. The check register and checks are held by the 
Chapter/Group treasurer. 

● Signature authorities on the bank account are to include 
Chapter/Group President, Chapter/Group Treasurer, and 
Executive Director of the MUW Foundation. 

● Two signatures are required on disbursements over $500. 
● Bank statements are to be mailed directly from the bank to the 

MUW Foundation and to the Chapter/Group treasurer. (MUW 
Foundation, 1100 College Street, W-1618, Columbus, MS 39701) 

● The Chapter/Group treasurer must submit to the MUW Foundation a 
monthly report of itemized deposits and checks which identify the 
donors who have made contributions, along with the date and 
contribution designation. The recap of checks should include date, 
vendor, and purpose. The Office of Development & Alumni has 
provided a template to be used for this reporting (see Exhibit 3). If no 
activity occurs, then a report does not have to be submitted. 

● The MUW Foundation reconciles the bank account and then 
prepares and submits a quarterly financial statement to the 
Chapter/Group treasurer and MUWAA treasurer. Quarterly 
reports are submitted by October 31, January 31, April 30, and 
July 31. 

● Deposits made for scholarship contributions must be remitted to 
the Foundation by check monthly. 

● The MUW Foundation will prepare and send thank you letters and 
receive tax receipts for all contributions to the chapter bank 
account. 

 
2. If the Chapter or Constituency Group chooses to maintain its funds within a 

designated fund at the MUW Foundation, all donations made directly to 
that fund through the University will be managed by the Foundation per its 
stated policies. However, if the group collects cash or check donations 
and/or dues directly from members, the following guidelines shall be 
followed. 

 
● The Chapter/Group treasurer must submit to the MUW Foundation 

monthly an itemized report of funds received which identifies the 
donors name, amount given, date received, and contribution 
designation. All money received should be included with this report. 
The Office of Development & Alumni has provided a template to be 
used for this reporting (see Exhibit 3). 



 

● The MUW Foundation will deposit these funds into the designated 
account upon receipt and will prepare and send thank you letters 
and tax receipts for all contributions to the respective donors. 

● All checks received should be made payable to the MUW 
Foundation. 

● If cash is collected, the cash must be delivered in person with the 
itemized report to the Office of Development and Alumni. If in 
person delivery is not possible, the cash should be deposited into a 
member’s account and that member write a check to the MUW 
Foundation for the full amount of cash received. A detailed 
statement should accompany this check showing the breakdown 
of donors for the check. Cash should never be sent through the 
mail. 

 
3. Chapter and Constituency Group funds are to be used for the sole benefit 

of the Chapter/Group or for the benefit of MUW. Bank accounts and 
Foundation Funds are maintained to meet Chapter/Group expenses and to 
provide support to MUW. 

 
4. Chapter and Constituency Groups may fundraise for the benefit of the 

Chapter/Group or the benefit of MUW. Fundraisers require review and 
approval of the Office of Development and Alumni. See Exhibit 4a for the 
Fundraiser form the Chapter/Group should submit for review, and Exhibit 4b 
for the informational / how-to guide regarding the entire fundraising 
process. 

 
5. Chapters and Constituency Groups must have a completed W-9 on file for 

any vendor that is an individual or partnership. The completed W-9 form 
should be mailed, not emailed, or faxed, to the Foundation office before the 
vendor is paid. For any vendor that a chapter/group pays $600 or more in a 
calendar year, a 1099 form will be issued by the Foundation. Please visit 
https://www.irs.gov/pub/irs-pdf/fw9.pdf for the current W-9. 

 
6. Chapters and Constituency Groups may offer non-endowed scholarships to 

MUW students once per semester. Funding for this type of scholarship may 
be through Chapter/Group Funds supported by the Foundation or through 
the Chapter/Group’s own account. However, all scholarship funds must be 
distributed through the University to the student’s account. 

II. PUBLIC STATEMENTS 
 

A. News Releases and Comments to the Media: Representatives of Chapters or 
Constituency Groups should restrict any news releases or comments to the 
media to information relative to Chapter or Constituency Group activities and 
events. Chapter and Constituency Group members are not authorized to 

https://www.irs.gov/pub/irs-pdf/fw9.pdf


 

represent or speak for the MUW Alumni Association or the University. The Alumni 
Office must approve any press release the Chapter or Constituency Group wishes 
to publish. Please allow one week for approval. 

 

III. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 
information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 
authorized in advance by the Office of Development and Alumni. 

 

IV. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 
information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 



 

authorized in advance by the Office of Development and Alumni. 
 

V. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 
information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 
authorized in advance by the Office of Development and Alumni. 

 

VI. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 
information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 
authorized in advance by the Office of Development and Alumni. 

 



 

VII. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 
information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 
authorized in advance by the Office of Development and Alumni. 

VIII. CHAPTER/GROUP MEETING AND EVENT PLANNING 
 

A. Thoughtful and Innovative Planning: Informative and enjoyable meetings and 
events are critical to a Chapter or Constituency Group’s success. Consider the 
diverse audience, choose meeting places that are attractive to a wide variety of 
alumni, plan thoughtfully, formulate an agenda for the meeting, and make those 
who attend feel welcome. It is University policy to avoid discrimination in any way. 
Meetings should not be scheduled for any location, time, or day that exhibits a 
discriminatory effect on participation. 

 
B. Requesting Dates and Speakers: When requesting approval for a meeting or event 

date from the Alumni Office, please do so for a minimum of eight weeks in advance. 
Please indicate the preferred University speaker(s) for the meeting or event. Every 
effort will be made to honor the request. All speaker requests must be made 
through the Office of Development and Alumni and not directly to the individual 
speaker. 

 
Depending upon the travel schedule of the President of the University or other staff 
members, the Office of Development and Alumni may request that a Chapter or 
Constituency Group in a particular area hold a meeting to coincide 

IX. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 



 

information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 
authorized in advance by the Office of Development and Alumni. 

X. CHAPTER/GROUP MEETING AND EVENT PLANNING 
 

A. Thoughtful and Innovative Planning: Informative and enjoyable meetings and 
events are critical to a Chapter or Constituency Group’s success. Consider the 
diverse audience, choose meeting places that are attractive to a wide variety of 
alumni, plan thoughtfully, formulate an agenda for the meeting, and make those 
who attend feel welcome. It is University policy to avoid discrimination in any way. 
Meetings should not be scheduled for any location, time, or day that exhibits a 
discriminatory effect on participation. 

 
B. Requesting Dates and Speakers: When requesting approval for a meeting or event 

date from the Alumni Office, please do so for a minimum of eight weeks in advance. 
Please indicate the preferred University speaker(s) for the meeting or event. Every 
effort will be made to honor the request. All speaker requests must be made 
through the Office of Development and Alumni and not directly to the individual 
speaker. 

 
Depending upon the travel schedule of the President of the University or other staff 
members, the Office of Development and Alumni may request that a Chapter or 
Constituency Group in a particular area hold a meeting to coincide with a 
University official’s visit to that area. This allows maximization of limited travel 
funds available.



 

 
C. Meeting and Event Details: Once the date has been selected and approved by the 

Office of Development and Alumni, each Chapter or Constituency Group should 
finalize all details. 

 
D. Invitations and mailings: When the final meeting information has been submitted 

to the Office of Development and Alumni, an invitation will be prepared, printed, 
and mailed or prepared and e-mailed from the Office of Development and Alumni. 
The Office of Development and Alumni will print and mail invitations to one 
meeting or event each fiscal year. Please allow six to seven weeks for the 
invitations to be printed and mailed after complete information has been received 
and approved by the Office of Development and Alumni. For additional meetings or 
events, the Office of Development and Alumni will provide printed and mailed 
invitations at cost. There is no cost for invitations sent via e-mail from the Office of 
Development and Alumni. The Office of Development and Alumni reserves the right 
to refuse any chapter/group mailing request submitted less than six weeks in 
advance and requests are approved based on the availability of funds. Chapters & 
Constituency Groups may not exceed First Class Postage per piece of mail. 
Additional cost should be covered by the requesting party. All mailings, except an 
event invite, must include a donation reference or donation form promoting giving 
to the MUW Foundation indicating the fund of choice. 

 

XI. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 
information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 
authorized in advance by the Office of Development and Alumni. 

 

 



 

XII. CHAPTER/GROUP MEETING AND EVENT PLANNING 
 

A. Thoughtful and Innovative Planning: Informative and enjoyable meetings and 
events are critical to a Chapter or Constituency Group’s success. Consider the 
diverse audience, choose meeting places that are attractive to a wide variety of 
alumni, plan thoughtfully, formulate an agenda for the meeting, and make those 
who attend feel welcome. It is University policy to avoid discrimination in any way. 
Meetings should not be scheduled for any location, time, or day that exhibits a 
discriminatory effect on participation. 

 
B. Requesting Dates and Speakers: When requesting approval for a meeting or event 

date from the Alumni Office, please do so for a minimum of eight weeks in advance. 
Please indicate the preferred University speaker(s) for the meeting or event. Every 
effort will be made to honor the request. All speaker requests must be made 
through the Office of Development and Alumni and not directly to the individual 
speaker. 

 
Depending upon the travel schedule of the President of the University or other staff 
members, the Office of Development and Alumni may request that a Chapter or 
Constituency Group in a particular area hold a meeting to coincide with a 
University official’s visit to that area. This allows maximization of limited travel 
funds available. 

 
C. Meeting and Event Details: Once the date has been selected and approved by the 

Office of Development and Alumni, each Chapter or Constituency Group should 
finalize all details. 

 
D. Invitations and mailings: When the final meeting information has been submitted 

to the Office of Development and Alumni, an invitation will be prepared, printed, 
and mailed or prepared and e-mailed from the Office of Development and Alumni. 
The Office of Development and Alumni will print and mail invitations to one 
meeting or event each fiscal year. Please allow six to seven weeks for the 
invitations to be printed and mailed after complete information has been received 
and approved by the Office of Development and Alumni. For additional meetings or 
events, the Office of Development and Alumni will provide printed and mailed 
invitations at cost. There is no cost for invitations sent via e-mail from the Office of 
Development and Alumni. The Office of Development and Alumni reserves the right 
to refuse any chapter/group mailing request submitted less than six weeks in 
advance and requests are approved based on the availability of funds. Chapters & 
Constituency Groups may not exceed First Class Postage per piece of mail. 
Additional cost should be covered by the requesting party. All mailings, except an 
event invite, must include a donation reference or donation form promoting giving 
to the MUW Foundation indicating the fund of choice. 



 

XIII. ALUMNI CONTACT INFORMATION AND RELEASE POLICIES 
 

A. Alumni Database Information: The database of records maintained by the Alumni 
Office, the Development Office, and the MUW Foundation represents confidential 
information about alumni and friends of MUW. In order to maintain privacy, the 
Alumni Office will not release any portion of those records except contact 
information for use in Chapter or Constituency Group programs planned with the 
Alumni Office according to the requirements outlined in these guidelines. Final 
authority in determining legitimate uses of the alumni records is given to the 
Director of Alumni Relations. 

 
B. Requests for Chapter Alumni Contact Information: All Chapter or 

Constituency Group requests for alumni contact information will be made in 
writing or by phone to the Director of Alumni Relations. 

 
C. Confidentiality: The confidentiality of the records must be maintained by the 

Chapter or Constituency Group in all cases and used for approved Chapter or 
Constituency Group events or meetings. No commercial or political use of alumni 
contact information is permitted. Use of contact information for any fundraising 
activity is prohibited unless it is for a Chapter or Constituency Group activity 
authorized in advance by the Office of Development and Alumni. 

XIV. CHAPTER/GROUP MEETING AND EVENT PLANNING 
 

A. Thoughtful and Innovative Planning: Informative and enjoyable meetings and 
events are critical to a Chapter or Constituency Group’s success. Consider the 
diverse audience, choose meeting places that are attractive to a wide variety of 
alumni, plan thoughtfully, formulate an agenda for the meeting, and make those 
who attend feel welcome. It is University policy to avoid discrimination in any way. 
Meetings should not be scheduled for any location, time, or day that exhibits a 
discriminatory effect on participation. 

 
B. Requesting Dates and Speakers: When requesting approval for a meeting or event 

date from the Alumni Office, please do so for a minimum of eight weeks in advance. 
Please indicate the preferred University speaker(s) for the meeting or event. Every 
effort will be made to honor the request. All speaker requests must be made 
through the Office of Development and Alumni and not directly to the individual 
speaker. 

 
Depending upon the travel schedule of the President of the University or other staff 
members, the Office of Development and Alumni may request that a Chapter or 
Constituency Group in a particular area hold a meeting to coincide 



 

with a University official’s visit to that area. This allows maximization of limited 
travel funds available. 

 
C. Meeting and Event Details: Once the date has been selected and approved by 

the Office of Development and Alumni, each Chapter or Constituency Group 
should finalize all details. 

 
D. Invitations and mailings: When the final meeting information has been 

submitted to the Office of Development and Alumni, an invitation will be 
prepared, printed, and mailed or prepared and e-mailed from the Office of 
Development and Alumni. The Office of Development and Alumni will print and 
mail invitations to one meeting or event each fiscal year. Please allow six to 
seven weeks for the invitations to be printed and mailed after complete 
information has been received and approved by the Office of Development and 
Alumni. For additional meetings or events, the Office of Development and 
Alumni will provide printed and mailed invitations at cost. There is no cost for 
invitations sent via e-mail from the Office of Development and Alumni. The 
Office of Development and Alumni reserves the right to refuse any chapter/group 
mailing request submitted less than six weeks in advance and requests are 
approved based on the availability of funds. Chapters & Constituency Groups 
may not exceed First Class Postage per piece of mail. Additional cost should be 
covered by the requesting party. All mailings, except an event invite, must 
include a donation reference or donation form promoting giving to the MUW 
Foundation indicating the fund of choice. 

  



 

MUW Alumni Association Annual Chapter & Constituency Group 
Status Report 

(Please complete this report and send to the Alumni Office by July 1) 

Date: Month Day, Year 

Name of Chapter: XYZ Chapter of MUWAA 

President: First Name Last Name 

Total Number of Active Members: 123 

Group or Event Photo 
Click Insert > Click Picture > Browse File > Select File > Click Insert 

ADD GROUP OR EVENT PHOTO HERE 

• Attach your Chapter or Constituency Group’s list of officers and directors, if applicable, with 
their contact information 

• List of exceptional things about the year 
• List of areas of improvement for the upcoming year 
• Explain how you publicize your events. 

Chapter Reminders 
• In addition to this Annual Status Report, an Event Report (Exhibit 2) should be completed after 

each gathering and submitted to the MUW Alumni Office. 
• For additional Chapter & Constituency Group support, please reach out to the Alumni office. 

They will put you in contact with the Chapters & Constituency Groups Committee. 

*Please contact the Office of Development & Alumni for an electronic copy of this template. 

  



 

MUW Alumni Association Annual Chapter & Constituency Group 
Event Report 

(Please complete this report and send to the Alumni Office following each event) 

Date: Month Day, Year 

Name of Chapter: XYZ Chapter of MUWAA 

Contact: First Name Last Name 

Contact’s Email:  

Event Location: 

Event Chair: 

Number of Participants: 

• Alumni 
• Students 
• Friends 
• Parents 

MUW Representatives Present: 

 

Preparation (phone calls, mailings, other publicity): 

 

 

List exceptional things about the event: 

 

 

List future improves for this event: 

  



 

MUW ALUMNI CHAPTER/CONSTITUENCY GROUP EVENT SIGN-IN SHEET 

Event:  Event Date: 

Chapter: Place: 

 

Name of Participant Alum/Student/Parent/Friend Class Year Phone E-Mail 

     

     

     

     

     

     

     

     

     

     

     



 

MUW Alumni Association Chapter/Constituency Group Itemized Report of Funds Received 
 

NAME/ADDRESS 
 

EMAIL 
PHONE 

NUMBER 
CLASS 
YEAR 

 
DUES 

 
SCHOLARSHIP 

SEND-OFF 
PARTY 

DATE OF 
DEPOSIT 

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        

        



 

Mississippi University for Women Alumni Association Chapters and 
Constituency Groups – Fundraising Form and Procedures   
Thank you for volunteering and fundraising for your Chapter or Constituency group in support of 
MUW. The University appreciates your continued efforts and monetary support! Below you will find 
the forms to complete and a “How To” on how to get your Chapter or Constituency  

Group’s fundraiser approved, organized, and going. 

After you review the attached Informational & How-to Guide, please fill out the following 
information in as much detail as possible. Please send this form along with your marketing plan / 
images to the Office of Development and Alumni for approval at least two weeks prior to your 
marketing start date.  

 

Name of Chapter or Constituency Group: 

Representative for Chapter or Constituency Group:  

Representative Contact Email:  

Dates of Proposed Fundraiser:   

 

Design and Marketing 
 

Description of Proposed Fundraiser Item:  

Design of Proposed Fundraiser Item (please attach):  

To whom will the Item be Marketed? (Select One): 

• Inside Your Chapter or Constituency Group Only 
• General MUW Public  

 

If the Item is Targeted to Members of Your Chapter or Constituency Group Only and Has YOUR 
Chapter or Constituency Group Specific Logos ONLY meaning NO University / MUWAA intellectual 
property or other logos/intellectual property your individual group does not own - then 
University/MUWAA Approval Process of the logo is not necessary. Please check with the Office of 
Development and Alumni to understand what constitutes MUW and Other Intellectual Property.  

 



 

 

If to the General MUW Public, please Identify Main Target Audience:  

IMPORTANT: If the Item is Targeted Toward to a General MUW Public Audience or Desires the Use of 
W or Other Intellectual Property, please reference the Information Guide and follow all approval 
processes. 

Pricing, Payment, and Information Catch:  
 

Price of Proposed Fundraiser Item:  

 

Will the Item be Distributed in Person or Shipped?:  

 

If Shipped, Approximate Amount of Cost for Shipping: 

 

Will Shipping be included in the Total Price?:  

 

Who will ship this:  

 

What company will be used?:  

 

Manner of Accepting Payment for Proposed Fundraiser Item:  

 

MUW Foundation Fund Fundraiser is Assigned To: 

 

Alum Information Collection Process Developed:  Yes / No (circle one)  

 

Collected Alum Information Shared with Office of Development and Alumni  

Date:  

Name of Individual Sent to:  



 

Mississippi University for Women Alumni Association Chapters and 
Constituency Groups – Informational & How-to Guide  
 

Fundraising Approval:  
Please send your fundraising idea and all designs to the Director of Alumni Relations and Donor 
Engagement. The Director of Alumni Relations and Donor Engagement will get it approved by the 
Executive Director of the MUW Foundation and MUW University Relations. If all is approved, the 
Chapter or Constituency Group contact will then be required to send proof of approval, and this 
completed form to the MUWAA President for final review.  

 

Pricing, Payment, and Information Catch:  

How do I Ship my items to the people who bought them?  
Your Chapter or Constituency Group is responsible for shipping items. If you are shipping items, it is 
suggested that you take one example of your physical item packaged to your chosen mail service 
center and have it weighed for shipping. Use this cost and round it up by $1 dollar to account for the 
price of item packaging. Provide this base cost in addition to the cost of the item to prospective 
buyers when you sell the item. It is recommended that one total cost (item cost + shipping) should 
be accepted from buyers when your item is sold.  

When you are ready to ship out your items, keep all shipping receipts and turn them into your 
organization to receive reimbursement for out-of-pocket costs.  

 

How to Accept Funds:  
Most Recommended  

Use of the MUW Foundation Website and a Foundation Fund. It creates an automatic collection of 
alum information for the MUWAA and MUW Foundation. It eliminates the need for fund transfers 
from personal or organization accounts to your MUW Foundation Fund.  

Other Recommendations  

Check, Cash (only with proper Information Collection), Paypal or Venmo  

Not Recommended 

Square or any service that charges a fee for use.  

 

 



 

What is a Foundation Fund and How does it work? 

 For more information on Foundation Funds and they work please visit this link: 
https://longblueline.muw.edu/foundation 

 

Why do I use Foundation Funds? 
Any donation to an MUW Foundation Fund is tax deductible and gives the donor automatic one year 
membership within the MUWAA.  

 

Collecting Alum Information:  
Why do I need to collect Alum information?  

Up to date Alum information is incredibly important to your MUWAA Fundraising efforts as well as 
records alum / buyer information for your Chapter or Constituency Group, the MUWAA, and the 
University. It also enables the buyer/alum to be recorded as an active member of your Chapter or 
Constituency Group and the MUWAA.  

How do I collect information?  

It is recommended that buyer information is caught at the time of item purchase. This can be done 
through the MUW Foundation website or information request at time of purchase via purchase 
instructions. If you are not utilizing the MUW Foundation website, information should be organized 
into an excel sheet for the purpose of sharing with the University and for your Chapter or 
Constituency Group’s records.  

What Information do I need to collect? 

At the very least please catch buyer individuals: Name, Email, and Physical Address . It is highly 
recommended to collect the buyer’s: Name, Email, Physical Address, Class Year, and Phone 
Number.  

Who do I send Collected Alum Information to at the University? 

If not given via the MUW Foundation website, Alum Information should be sent to the Director of 
Alumni Relations and Donor Engagement at the University Office of Development and Alumni.  

 

 

 

 

 


